Entry-Master® Systems Technical Guide

Installing a THEOS Workstation

Installing a THEOS Workstation

1. In Windows Explorer, locate the appropriate THEOS Workstation executable as directed by

an Entry-Master® System technician.

Falders Mame Size | Type M odified
@ Desklop [ THEOSWS File Fo... B8/13/02 4:22 PM
-8 My Computer CINCDTREE File Fo..  B/12/02 2:47 PM
é 3% Flappy [4:) 23 My Music File Fa...  4/24/0211.20 AM
EN= C350uUMD File Fo...  4/11./0211:45 &M
{1 DISK1 Capisk File Fo..  10/31/01 313 PM
B My Documents [C1RECYCLED File Fa...  10/30/01 2:56 PM
2 My Music My Docun?e THEOS Workstation F?Ie Fo.. 10430701 2:40 P
-{"] MCDTREE [Z1 Pragram File Executable file File Fo...  10/30/01 11:58 AM
L1 Program Files CIwIND Dws File Fa.  10/30/01 11:58 AM
{1 RECYCLED [C1wiNIEDRY File Fa... 9/26/01 1:29 PM
M- SOUND ﬁ R e rel Y / 106,496... SWP ... 10/9/0212:48 PM
-1 THEOSWS ] s 23400 e 311EKE  Applic..  10/9/02 12:45 PM
- WINSEDRY by e 1KB  EM4 File 1047402 10:22 A
E-CT WINDOWS rep26. emd 31KB  EM4File 10/1/0212:31 PM
a1 JAMS T T [Z|REFP25.EMS 1KE  EM4File 9/9/02 424 PM

Figure 1. Windows Explorer

2. Double-click on the executable.

3. When the first installation window appears, minimize the window and close Windows

Explorer.

THEDS WorkStation - InstallShield Wizard

THEOS WorkStation
Wersion 2.34
By Advanced Software Technologies, S A,

A THEDS terminal emulatar that connects your
Windows™ systern to THEOS wia network TCPAP

or RE-232 serial connection.

Compatible with Windows 95/98@ and
YWindows NTE.

email: ast@theos es

< Bach I Mext > I

Cancel |

Figure 2. Installation Splash Screen

4. Maximize the Installation window. As you click the Next button to navigate through the
installation screens, use the following to answer any appropriate prompt.

5. Click OK to leave English in the Choose Setup Language.
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Chooge Setup Language

[Elj Select the language far thiz installation fram

the choices below.

oK I Cancel |

Figure 3. Choose Language

6. Click the Next button on the Installation Welcome Window.

Install5hield Wizard

Welcome to the InstallShield Wizard for THEOS
WorkStation

The InzstallS hield® Wizard will install THEQS “WorkStation
on your computer. To continue, click Mewt.

Cancel |

Figure 4. Installation Welcome Window

7. Do not change the Destination Folder that appears on the Choose Destination Location
window. Click Next to continue.

InstallShield Wizard

Choose Destination Location

Select folder where Setup will install files.

Setup will install THEDS WorkStation in the Following falder.

Toinstall tothiz folder, click Mest. Taoinstall to a different folder, click Browse and select
another folder.

C:\Prograr Filez\AS TATHEDS *WarkStatian Browse. . |

[ Frstall=hield

" Destination Folder

Cancel |

Figure 5. Choose Destination Window
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8. Click Next on the Select Program Folder window to accept the default Program Folder on
your system.

Install5 hield Wizard

Select Program Folder

Flease select a program folder.

Setup will add program icons to the Program Folder listed below. You may tppe a new folder
hame, or select one from the existing folders list. Click Mt to continue.

Program Folders:
THED S

Ezisting Folders:

Macromedia FreeHand 10 ;I
Microsoft Office Tools

Martan Systermwiorks

PrecisionTime

Snaglt B

Snaght Studio

Y ahool M eszenger *2

| FrstallStield

< Back | Mext » I Cancel |

Figure 6. Select Program Folder Window

9. Click on the check box next to Desktop on the Setup Type window. This will place a
shortcut on the desktop of your computer.

InstallShield Wizard
Setup Type

Choose the setup type that best suits vour needs.

Pleaze, place a link to THEDSWS in:

¥ Deskiop
™ Quick Launch

[FrstallShield

< Back | Mext » I

Cancel |

Figure 7. Select Desktop Setup Type

10. Click Yes to restart your computer now.
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InstallShield Wizard

InstallShield Wizard Complete

The InstallS hield ‘Wizard haz successfully installed THEDQS
WiorkStation. Before you can uge the program, pou musgt
resstart your cornputer,

& ¥z | warl to restart my compuber now )

Mo, | will restart rmy computer later,

Remove any disks from their drives, and then click Finish to
complete setup.

< Back | Finizh I Caneel

Figure 8. Restart Computer

Configuring the Workstation
11. When the desktop displays, double-click on the THEOS workstation icon.

Figure 9. TheosWS Icon

12. Click the No button in the following notification window.
THEOSWS E

& Do you want THEDSWS to notify whenewver a newer version becomes available?

Figure 10. Notify Newest Version

13. The Disconnected message, as shown in the following figure, appears prior to configuring
the workstation to point to the Entry-Master® System.
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€ Untitled] - THEDS WorkStation
File Edit Session Configuation Options ‘“findow  Help

LBt 08

*%% Disconnected *ex

Disconnected [ |NOmM 1010 [10:448M (050,012 g

Figure 11. Untitled 1 — THEOS Workstation

14. The Toolbar at the top of the screen contains a monitor icon which is circled in the
following illustration.

DeHd Sa 8w HEg(akasr 0

Figure 12. Toolbar

15. When you click on this icon, the Display setting window displays.
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Display [ 2]
— Dizplay Size — Font
Columns: IBD Fort Twpe: Size:
Rows: |29 Terrninal 14
B | etter Gathic - 3 -
— Ermulation Clazs | Lucida Console _I 5 _I
£ Class 90 % M5 Mincho 9
OCH A Estended 12
® Lol -m—ﬁ s
& [Class 210
— Screen/Cursor coupling— Sample
™ Horizontal ’7 I AaBb®* £
™ ‘ertical
i SemiGR Mappi
~ Control Codes [~ Fontautosize | Semi apping
' |nterpret ¥ Controls Mapping
 Digplay . .
= Window Title
s
~ Display Mode " Name server € Program executian -
' |ncremental mode " Ascount & Fived name Lancel |
" Block mode IF_ntry-Master Syz
= Help |

Figure 13. Display Settings Window

16. In the Display window make the following changes.

a.

Under Display Size, change Rows to equal 29. You may change Rows to equal 24
depending on your monitor type.

Under Font, change Size to 14, if available. Note that for some monitors Size 9 may be
the only size available.

Make sure that Font autosize is turned off. (The check box is blank.)
Controls Mapping should have a check mark in the box.

Under Window Title, select the Fixed Name radio button.

Type in Entry-Master System IV in the box below Fixed Name.

Do not change any other fields, leaving the default information in these fields.

Click OK to save your display settings and close the window.

17. The screen now reflects the changes you made in the Display settings window.
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l'f Entry-Master System IV - THEDS WorkStation
File Edit Session Configuation Options ‘“findow  Help

H= E

Delaa

EEIEE e AN

=x* [isconnected ===

I ——Divecosected

E E iiiii ST Joen ogon |

Figure 14. After Display Settings Changes

18. Select the Options menu from the menu bar then click Status Bar to turn it off. The menu
will close. Click on Options again to insure the check mark does not display next to Status

Bar.

Options  Window  Help
v Tool Bar

v Statug Bar

v Show Menu

v Emulation Frame

Full Screen

Save Prafilz on exit »

Status Bar On

Options  Window  Help
v Tool Bar
Status Bar
v Show Menu
v Emulation Frame

Full Screen

Save Prafile on exit ¥

Status Bar Off

Figure 15. Options Menu

19. Select the Options menu again and highlight Save Profile on exit, and then click on Do

not save profile.

20. Click on Options again and highlight Save Profile on exit to insure the check mark does

display next to Do not save profile.
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Options  Wwindow  Help

v Tool Bar
Statuz Bar
v Show Menu

Full Screen

v Emulation Frame

21.

Figure 16.

Options  Wwindow  Help

v Show Menu
v Emulation Frame

Tool Bar
Statuz Bar

Full Screen

: Profile on exit » Aszk on exit

Always save profile

Click on Configuration on the Menu bar.

Do not save profile

Configuration  Options

Dizplay...
Preferences. ..

Slave Printer..

LColars....

Special Keps.

Mizcellaneous...

Figure 17. Configuration Menu

22. Click on Preferences and the Preferences Setting window appears.

Preferences BE
— Connection — Key Status
Server: E ritry-p aste % Cuent walues
Account I € Emulation valuss
MI € Figed values

Easswnr: I -
™ Euit on Disconnectior ™ Euit ind Mot Dizconnes r [aps
™ Autodisconnect = | i
r— Slawve Printer

Drivver

it Humber: I EL:I

% THEDS Class: I LL:I

Frinter |
,TI Qancell Help |

Figure 18. Preferences Window

23. Make the following entries in the Preferences Window:

a. If Entry-Master does not appear in the Server field, you need to enter the Server’s IP

Address.

b. Type in LOGO in the Account field.
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c. Place a check mark (by clicking the box) next to Exit on Disconnection.
d. Also, place a check by Autodisconnect.

e. Inthe Number field type 1.

f. Type 135 in the Class field.

g. All other entries remain unchanged. The following figure illustrates these settings.

Preferences [x]

— Connection ~ Key Status
Server: IEntry-Maste[ j & Cunent yalues
Account ILDGD € Emulation values
) _lCon[igure ™ Fiwed valuesz
Pazzword: I -
¥ Exit on Disconnectior [~ Exit&nd Not Disconnec I= | Caps
¥ Autodisconnect I | Kl
~ Slave Printer

Dirivver

£ Wlindows MHumber: |1 pL:A%8

&+ THEDS Class: [135 LL;|80

Printer |
ok I Cancel I Help I

Figure 19. Settings for Preferences Window
24. Click OK to save your entries and close the Preferences Window.

25. Once again, click on the Configuration menu and select Special Keys.

Configuration  Options

Dizplay...
Preferences...
Slave Printer...
LColars...

Special Keps...
Mizcellaneous...

Figure 20. Configuration Menu

26. The Special Keys window appears.
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Special Keys EHE
—Feys

| Al

[™ Frint Screen

Vi

LCancel

4l

Help

—dcceleratar

[shit x|*jcm =] +[F0 =]

Figure 21. Special Keys

27. Click in the check box next to F1 to identify F1 as a special key for the Entry-Master®
System.

28. From the File menu, select Save As.

Save Profile EHE
Saven: | ‘=3 THEDS WorkStation = =]

File name: | Save

Save as type: | Profile Files [ tpf] i Carcel |

Figure 22. Save As

29. In the File Name field, enter em. When you click on Save, you will be saving profile
called em.tpf.

30. On the Toolbar, click on the Connection icon which is circled in the following illustration.

IEEEAE I EE €D

Figure 23. Connection Icon

31. The following Connect window displays.
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Connect

Servern

|0 GO@E ntry-taster: 3299
g Entry-tMaszter

Figure 24. Connect

[Eanfigure

i

Refresh

Cancel

dil;

Help

32. Select Entry-Master then click OK. The Entry-Master® System Logo screen displays.

Entry-Haster Svustems, Inc.

— 1
Cntry-

Entry-Master
C Systems, Inc -

=% Copyright ==
(c) 1990-2001
by EMS, Inc

Version 4.1.2
200-01115

Security
Management
Sustem IV

|

NastBer

Trademark

Entry-Master EMS, Inc.

A1l Rights Reserved.

Login Name: B

Figure 25. Entry-Master Log On Window

33.
the correct system displays.

34. Exit from the Entry-Master® System.

35.
Properties window appears as shown next.

Use a valid Login Name and Password to log into the Entry-Master® System. Verify that

Right-click on the THEOS icon and select Properties from the list that displays. The
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TheoswS Properties

Gereral Shortout |

Q Theosws

Target type: Application

THEQS “wark Station

Target location:

Target:

Start in; I

Shartzut key: INDI"IE

B

INormaI window

Find Target... | Qhangelcon...l

el |

Figure 26. Properties Window

36. In the Target field, replace the words “theosws.exe” with “em.tpf”. Do not remove any

quotes.

37. Click on the Change Icon button.

Change Icon

File name:

Current icon;

Cancel | Browsze. . |

Bl

Figure 27. Change Icon

38. Click Browse to select an appropriate icon.
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Change lcon H

File name:
C: NN D DWw/SASYSTEMASHELL 32 DILL

Eurrent[igon'

.@Eﬁ“@ PO H
H2OmlH @,
lﬁ%#ﬁ@@
=S8 & @ 9Ty
>

KN —
(.4 I Cancel | Browse... |

Figure 28. Icon Selections
39. Double-click on the appropriate icon and the Properties window redisplays.

40. Click OK to close the Properties window. When the desktop refreshes, the new icon
appears:

Figure 29. New Icon Appears

Opening an Entry-Master® System Report in a Word Processor

Once the workstation is installed, you can configure your PC to open your Entry-Master®
System reports in a word processor application. Also, you can create a shortcut to this report
file on your desktop for easy access. To do this:

Run an Entry-Master® System Report:
1. From your desktop, double-click on the Entry-Master® System icon.
2. Log in to the Entry-Master® System.

3. Access the Report option from the Main Menu.
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Hain Menu
1. Cardholder Search/Edit
2. Enter Reports Menu >

3. Enter Utilities Menu >

Enter Event Monitoring
Enter Alarm Monitoring
Enter Count Monitoring

Change Your User Password
Manual Door/Gate Control...

(Y=} (= N [=p Nyl o]

Exit Entry-Master System IV

Figure 30. Enter Reports Menu

4. Select any report type from the Reports Menu.

Main Menu q

Reports Menu
ol 1. Card/System Event Reports »
Card/System Alarm Reports »
Card Database Reports >
Card Revenue Reports >
Ticket Rewvenue Reports >
Configuration Reports >

¥

Custom Reports Menu

¥

. System User Audit Reports
. Elevator Control Reports

NOCD | wd | DN AL NS

¥

18. Report Utilities Menu >
11. Enter Count Sustem Henu

¥

12. Return To Main Menu

Figure 31. Card/System Events Reports Selected

5. Select any report to run.

Main Menu
Reports Menu
— B Event Reports Menu
1. List Activit
. l; by Date and Time
. Activity by Department
. Activity by Card Humber
. List Activity by Device
. Activity by Device & Time
. Activity by Sensor & Card
. Valid Activity by Card #
. Pass-Backs by Card Number
. A1l Exception Activity
. Exceptions by Card Number
. Exceptions by Device
. Malfunctions by Device

. Nesting Reports Henu

. Return To Reports Menu
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Figure 32. List Activity by Date Selected

6. When you press <Enter>, a Report Output Menu dialog box appears as shown in the
following figure.

7. Press the <down arrow> until Review Report via Word Processor is highlighted.

= Susten Euent Report Output Henu ———
Exit » Exit back to Event Reports Menu

Screen * Type the Event Report to the Screen
Printer * Print the Event Report to the Printer

Figure 33. Highlight Review Report via Word Process
8. Press <Enter> and the Entry-Master® System asks you for a date range.

9. Press <Tab> in either the Starting Date or Ending Date field to automatically enter
today’s date. Or, you can press <F2> and select a date from the calendar that displays.

11/085/2002
11/685/2002

Tab> Today F2> Calendar

Figure 34. Enter a Date Range.

10. Press <Enter> to begin report processing.

11. If this is the first time you have run an Entry-Master® System report from this PC, the
following message may display:

c:\rep24_emd

Thiz file doez not have a program associated with it for performing this action. Create an
azsociation in My Computer by clicking Yiew and then clicking Folder Options.

Figure 35. No Program Association Message

a. If this message does not display, your report should open in a word processing

application. Continue to the “Creating a Shortcut” subsection below if you need to add
a desktop shortcut for this report.

b. If this message displays, click OK, and the report menu redisplays.
1) Log off the Entry-Master@ System.

2)  Proceed to the next subsection “Open With a Word Processing Application.”
directions.
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Associating a Word Processing Application:

When Entry-Master® System sends a report to a word processing application, it creates a file on
your C drive that has an “.EM4” extension. Typically, the file name is REP##.EM4. (The “##”
is a two-digit sequential number that appears after “REP.”) If your report does not open as
described above, you need to select a word processing application to open this extension. Use
the following steps to open REP##.EM4 with the appropriate word processing application

1. Open your C directory using the Explorer.

2. Locate the REP##.EM4 file in the list.

Falders X Mame Size | Tvpe M odified
7] Deskiap &{|CaTHEDS WS File Fo...  8/19/02 4:22 PM
-8 My Computer CINCDTREE File Fo..  B/12/02 247 PM
El-28 3% Floppy [4:] [ My Music File Fo...  4/24/0211:20 &AM
R ) Ca50UND Fils Fo..  4/11/0211:45 AM
-1 DISKT CaDISK File Fo..  10431/01 313PM
-1 My Dacuments I RECYCLER File Fo..  10/30/01 255 PM
03 My Musie [ My Dacur| EMS file that contains the | FileFo.. 10/30/01 2:40 PM
("] NCDTREE CdProgram Fil most recently run report | FileFo..  10/30/01 11:58 ﬂMI
-0 Program Files CawiNDow (REP##.EMd) File Fo...  10/30/07 11:58 &M
{1 RECYCLED CIWINSSDRY File Fo..  9/26/011:23 P
&0 S0UND ] wiN3EE S WP ./ 108496 SWP.. 10/9/0212.42PM
3 THEOSWS ol bass 22400 e 3116KB  Applic..  10/8/0212:45 PM
B0 WINSSDRY REP24.EM4 KB EMd4 File 10/7/02 10:22 &M
{:I WD OS =] rep2e-emd HKE  EM4File 1041/0212:231 PM
Al DD /| REP25.E M4 KB EMd File 3/3/02 424 PH

Figure 36. Sample REP24.EM4 File

3. Double-click on file name and the following Open With dialog box displays:

Open With EHE3

Click the program you want to use to open the file
'‘REFP24.EM4".

If the program you want iz not in the list, click Other.
Description of " Eb4* files:

LChoose the pragram you want to uge: %
UNEIND A
b wab

Fuwbaz

4 winhlp32

[ varewvorD

E¥wORDPAD -
& WScript LI

W Ahwayz uze this program to open this file

[t I Cancel | Qther... I

Figure 37. Open With Dialog Box
4. Scroll down the list to select a word processing program.

5. When you double-click on the appropriate word processing icon, the report opens in that
application. Any subsequent reports you run will open in this program.
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Creating the Shortcut:

As previously explained, when the Entry-Master® System sends a report to a word processing
program, an REP##.EM4 file is created on your C drive. (The “##” is a two-digit sequential
number that appears after “REP.”) To create a desktop shortcut:

6. Open your C directory using the Explorer.

7. Locate REP##.EM4 in the list.

Falders M ame Size | Type Modified
:\d Desktop =] I THEOSWS File Fo... 8/19/02 4:22 PM
EI_%‘ My Computer CINCDTREE File Fa... B/12/022:47 PM
é 3% Floppy [4:) [Z1 My Music File Fa...  4/24/0211:20 AM
2= 3 50uUMD File Fo...  4/11/02 11:45 AM
-] DISK1 CJpiski File Fo...  10/31/01 313 PM
B0 My Documets _IRECYCLED File Fa...  10/30/01 2:56 PM
- My Music [C1 My Documents File Fo... 1030400 2:40 PM
-{_7 NCDTREE [Z1 Pragram Files File Fo... 10430401 11.58 AMI
&1 Program Files CIwiNDOws File Fo... 10430401 11:58 A
-] RECYCLED 1 wWINSEDRY File Fo...  9/26/01 1:29 PM
M- SOUND "k 386.5WF 106496 SWwWP .. 10/9/0212.48 PM
7 THEDSWS ﬁ twz23400 exe I16KR  Applic..  10/9/0212:45 PM
-0 WINSSDRY REF24.Ebd 1KE EM4File 10/7/0210:22 AM
-0 WINDDWS rep26.emd 31KB  EM4File 10/1/0212:31 PM
i late D0 |2 REP25.EM4 1KE E-M4 File  9/9/02 4:_24 P

Figure 38. Sample REP24.EM4 File

8. Right-click on this filename and select Send To followed by Desktop (create shortcut) as
illustrated in the next figure.

DOpen

Scan with Morton Antiing

SendTo d = [ElJaz 1GE
Cut é‘ 3% Floppy [4)
Copy [ op [cre
Create Shortcut (©) FresHand 10
Delete B4 Mail Recipient
Rename .

Microzoft Excel
Properties Microzaft waord

M MEPAINT EXE
ﬁ My Documents
@ Wordpad exe

Figure 39. Sent To Desktop (create a shortcut)

9. When you release the mouse button, the following message displays:

Shortcut [ ]

@ The new shartcut will be placed on the desktop.
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Figure 40. New shortcut message
10. Click on OK.
11. Locate the shortcut on your desktop

12. Right-click on the shortcut icon and select rename from the popup menu.

Open

Scan with Morton Antivins
SendTo »
Cut

Copy

Create Shortout

Delete

Rename I
Properties I

Figure 41. Rename

13. The current name is highlighted. Type “Entry-Master Reports” and press <Enter>. The
shortcut displays this new name.

-

I
7]

E ntry-bd aster
Feportd

Figure 42. Type in shortcut name

Note that the Entry-Master® System is programmed to replace the information in this file every
time a report is run. If you wish to save a certain report, select Save As from the File menu and
save it as a different name. Otherwise, Entry-Master® System writes over this information the
next time you run any report.
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